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What Is the Network Identity Manager and When To Use It?

Network Identity Manager (NetldMgr) is a graphical system-tray tool designed
to manage Kerberos identities on Microsoft Windows. NetldMgr is used to
_ obtain Kerberos tickets (aka credentials), change the Kerberos password, and
obtain Andrew File System (AFS) tokens for one or more AFS cells”.

NetldMgr combines the functionality of several command line tools a user
would use to manage Kerberos functions: kinit, klist, kdestroy, ms2mit, akog’,
and passwd or kpasswd. NetldMgr combines all of these functions into one user
interface and supports automatic renewal or user notification when credentials

;

are approaching expiration.

There are many ways to execute NetldMgr. In addition to clicking on a Network Identity Manager
shortcut, you can start NetldMgr from the Windows command Prompt or Run... option. Command-line
options may be specified. If you run NetldMgr with the options -i or --kinit, it will display the ticket
initialization dialog and exit; -m or ——-ms2mit or —import will import tickets from the Microsoft Windows
logon session (if available) and exit; -d or -destroy will destroy all existing tickets and exit; -r or —renew
will renew existing Kerberos tickets (if possible) and exit; -a or —-autoinit will display the ticket
initialization dialog if you have no Kerberos tickets.

You may create a shortcut to NetldMgr within your Windows Startup folder (Start Menu->Programs-
>Startup). A shortcut to “NetldMgr.exe —autoinit” ensures that Kerberos tickets are available for the use
of Kerberized applications throughout your Windows logon session.

NetldMgr is most commonly started immediately after the Windows Logon and remains running in the
Taskbar until you logout. While running in the Taskbar, NetIDMgr automatically renews your credentials,
notifies you of pending expirations and can prompt you when a Kerberized application requires credentials
that you have not already obtained.

When configured to do so, NetldMgr will prompt you immediately after it starts to obtain Kerberos
credentials. This is often referred to as logging on to Kerberos. NetldMgr does not perform a logon in the
sense of the Windows Logon Service. A logon service would do more than manage Kerberos tickets. A
logon service would authenticate you to the local machine, validate access to your local file system and
performs additional set-up tasks. These are beyond the scope of NetldMgr. NetldMgr simply allows you to
manage Kerberos identities on behalf of compatible applications and to change your Kerberos password.

“ An optional OpenAFS plug-in is required.
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Network Identity Manager Screen Display

The window title contains the name “Network Identity Manager”. Below the title are a menu bar; a tool
bar; and a tree view.

M Network Identity Manager

File Credential View Options Help
DR EE® O
b2 Identity Type Service Name Time Remaining
B & [y jstman@ATHENA MIT EDU {Diefault)
[El Kerheros Stickets
EA krbtgt/ATHENA.MIT.EDU@ATHENA.... 18 hours 4 minutes
o afz/athena mit edu@ATHENAMIT.EDU 18 hours 4 minutes
3 afs/dev mit.edu@ATHENAMIT.EDU 18 hours 4 minutes
£ afs/iastate edu@IASTATE.EDU 18 hours 4 minutes
B afs/net mit. edu @ATHENA MIT.EDU 18 houwrs 4 minutes
£ afs/raebum org@RAEBLIRN ORG 6 hours 45 minutes
By afs/so0ap mit edu@ATHENAMITEDU 18 hours 4 minutes
ES afs@ANDREW CMU EDU 18 hours 4 minutes
£ afs@C5 CMULEDU 18 hours 4 minutes
B3 fs@DEMENTIAORG 18 houwrs 4 minutes
£ host/drugstare mit edu@ATHENAMIT... 18 hours 4 minutes
B host johnstown.andrew .cmu edu@AN... 18 hours 4 minutes
B3 krbtat/ANDREW CMU . EDU@ATHEN... 18 hours 4 minutes
B kerbtgt/C5.CMU.EDU@ATHENAMIT.... 18 hours 4 minutes
£ krbtgt /DEMENTIA. ORG@ATHENAM. .. 18 hours 4 minutes
£ krbtgt IASTATE. EDU@ATHENAMIT.... 18 hours 4 minutes
ES krbtgt /RAEBURN ORG@ATHENAMI... 18 hours 4 minutes
[F AFS tokens
- Kerberos 4 tickets
o krbtgt ATHENAMIT EDU@ATHENA.... 7 hours 24 minutes
A (3] jatman@JPLNASAGOV
B & [y jstman@SECURE-ENDFOINTS.COM
) Kerberos Sticksets
ES krbtgt /SECURE-ENDPOINTS COM@... 18 minutes
B krbtat /ATHENA.MIT EDU@DEMENT... 18 minutes
& krbtgt/DEMENTIA ORG@&SECURE-E... 18 minutes ’ ' |
|

In its default configuration, the NetldMgr tree view displays a list of user identity names (aka Kerberos
principals, user@REALM). Each entry appears with a = or = button, a @ or 42 button and an Identity
icon [ to its left. Click on the & button of an identity to expand the branch, displaying a = putton.
Click on the & button to hide the branch.

Below each user identity, the tree contains credential categories. Below each credential category are the
current credentials (tickets or tokens) belonging to the group. Each credential entry contains the current
credential status, the service name and time remaining before expiration.

The tree updates once per minute. If you need an immediate update of your ticket status, you can either
click in the window or the press the Update Display button on the toolbar.

To the right of each credential is a flag icon representing one of the following states:
None = credentials are valid

&8 = credentials are valid and renewable
.4 = credentials are valid and the initial expiration warning has been issued
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i

Gt = credentials are valid and the final expiration warning has been issued
) = credentials are invalid or expired

At 15 minutes” before expiration renewable credentials will be renewed automatically.

¥ Network Identity Manager |Z”E”5.__<|
File Credential View Options Help

DN E&E @
\:? Identity Type Service Name Time Remaining
[ jaltman@ATHENA MIT EDU {(Defauit)
40 [3] jsltman@JPLNASAGOV
& [y jatman@SECURE-ENDPOINTS.COM
[ Kerberos Stickets
|} kerbtgt SSECURE-ENDPOINTS.COM@... 5 minutes 10 seconds
(R} kerbtgt /AATHENA MIT EDU@DEMENT... 5 minutes 10 seconds
|| krbtgt /DEMENTIAORG@SECURE-E... 5 minutes 10 seconds 1 {

At 10 minutes and 5 minutes” before your credentials expire, a balloon tip is displayed to warn that your
credentials will soon expire and to provide you the opportunity to obtain new ones.

M Network Identity Manager
File Credential View Options Help

DR E&® @
i Identity Type Service Name Time Remaining

4[4 jaltman@ATHENA MIT EDU {Defauit)
40 [§] jstman@JPLNASAGOV

[ kerbtgt SSECURE-ENDPOINTS.COM@... 4 minutes 35 seconds

E3 ferbtgt /ATHENAMIT EDU@DEMENT... 4 minutes 35 seconds

e8| kerbtgt /DEMENTIA.ORG@SECURE-E... 4 minutes 35 seconds "a:,
L P

Credentials that are not renewed will expire.

“ The actual time is configurable. 15 minutes is the default time. Automatic renewal may be disabled.
* The actual times are configurable. 10 minutes and 5 minutes are the default times, Expiration warnings
may be disabled.
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M Network Identity Manager
File Credential View Options Help

OREfme O
e |dentity Type Service Name Time Remaining
™ [ jaltman@ATHENA MIT.EDU (Default)
40 [§] jstman@JPLNASAGOV
O @ [} jatman@SECURE-ENDPOINTS COM
£ Kereros Bickets
kerbtgt /SECURE-ENDPCOINTS.COM@ ... (Bxpired)
kerbtgt /ATHENA.MIT EDU@DEMENT...  (Expired)
lrbtgt /DEMENTIAORG@SECUREE... (Bxpired) |
L |

[2]=]7)

Andrew File System (AFS) token management is available only on machines that have installed OpenAFS
for Windows” and that have installed the required plug-in®.

The Network Identity Manager manages multiple identities. Most applications do not know how to
request a specific identity or how to search for the appropriate credentials cache. Instead these applications
assume that the identity to be used is stored within the default credentials cache. NetldMgr allows one
identity to be specified as the default identity.

The push pin buttons are used to choose whether an identity should be displayed even when there are no

credentials. ‘@ indicates that the identity will be displayed without credentials. 2 indicates that the
identity will not be displayed without credentials. The buttons act as a toggle between the two states.

# OpenAFS for Windows 1.4.1 or higher is required. http://www.openafs.org
% Until such time as the OpenAFS Credential Manager plug-in is integrated into OpenAFS for Windows, it
can be obtained from Secure Endpoints Inc. at no charge. http://www.secure-endpoints.com

Page 6



Network ldentity Manager User Documentation Release 3.1.0

Network Identity Manager Command Line Options

When NetldMgr is executed from the command line one of the following command line options may be
specified:

--kinit, -i performs a Kerberos ticket initialization (and exits)

--ms2mit, --import, -m imports credentials from the Windows Logon Session (and exits)
--renew, -r renews credentials (and exits)

--destroy, -d destroys credentials (and exits)

--autoinit, -a performs ticket initialization only if the credential cache is empty
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Network Identity Manager Commands

File:
=8 Credential View Options Help
Properties ...
Exit CTRL+X
Properties...

From the File menu, will display the Properties dialog for the currently selected item whether it be an
Identity or a Credential.

jaltman@ATHENA.MIT.EDU Properties

Identity |

Mame halhﬂan@.ﬁ.THEN.ﬁ..MlT.EDLl
Default identit Always visible (sticky)

Froperty Value

Expires an 12/3/2005 4:43:56 PM

Flags FRI

Issued on 12/3/2005 3:40:59 PM

Krb5 CCache API:jaltman@ATHENA.MIT.EDU

Rernewable time expires  12/10/2005 2:10:5% PM

[ Identity configuration ...

[ Ok l [ Cancel App

An ldentity Property dialog
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' kebtgt/ATHENA. MIT.EDU@ATHENA. MIT.EDU Prope... | 2 59|
m| Credential | Identity |

Mame krbtgt/ATHENA.MIT,EDU@ATHENA.MIT,EDU|
Issued on 12/4/2005 6:34:21 PM
Valid il 12/4/2005 7:37:15 FM
Renewable til 12/11/2005 6:34:21 PM
Ticket flags Forwardable

Initial

Renewable

(04 l [ Cancel ] App

A Kerberos 5 Ticket Property dialog

- -1
—
krbtgt/ATHENA.MIT.EDU@ATHENA.MIT.EDU Prope...
Kerberos 5| Credential | Identity |
Property Value
Expires on 12/4/2005 7:37: 15 PM
Flags FRI
Identity jaltman@ATHENA. MIT.EDU
Issued on 12/4/2005 &:34: 21 PM
Key EncType DES-CBC-CRC
Lifetime 1 hour 2 minutes
Location APT:jaltman@ATHEMA, MIT.EDU
Renewahle lifetime 7 days
Rernewable time expires 12112005 6:34:21 PM
Service Name krbtot/ATHENA.MIT.EDU@ATHEMA. . .,
Ticket EncType DES-CBC-CRC
Type Kerberos 5 tickets
()4 l [ Cancel ] App

Associated credential properties

The properties dialog can also be displayed by pressing the [M button on the Identity header, by double
clicking a credential, or by clicking on the credential status flag.

Exit Command
From the File menu, you can use this command to exit the Network Identity Manager.
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Important Note...
Exiting the Network Identity Manager will not destroy your current credentials. Unless you have chosen to

delete credentials on exit from the General Configuration page, you need to use the destroy credentials
command.

Credential:
File View Options Help
" Mew credentials ... CTRL+N
ul_Renew credentials CTRL4R
M Import Credentials CTRL+I
&

" Destroy credentials ... Del

Set as default

(¥ Change password ...

New Credentials Command, Ctrl+N

This command is found under the Credentials menu; it is also the first button \j(from the left) in the
toolbar. Use this command to obtain new credentials.

by jaltman@SECURE-ENDPOINTS.COM - New credentials

Username | . |
Realm | SECURE-EMDPOIMTS, COM w |

Password for jaltman@SECIURE-ENDPOINTS. COM

Credentizls  |Selacted identity: jaltman@SECURE-ENDPOINTS.COM
Mot default identity. (make default)

Krb5 : Creds for realm SECURE-EMDPOQINTS.COM

AFS : Token for cell secure-endpoints .com

Krb4 : Disabled (click here to enable)

Ok ‘ | Cancel ‘ ‘ Options ==

When you select this command, NetldMgr displays a dialog requesting your Username, Kerberos Realm,
and Password; if these are correct, NetldMgr will obtain tickets for you. You may optionally specify
options for each of the credential types.
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by jaltman@SECURE-ENDPOINTS.COM - New credentials

Kerberos 5 Ticket Options

Fealm Ok
e Cancel

Lifetime 20 minutes

Renewable for 7 days

Can be forwarded to other machines

Addressless

e
Identity Kerberos 5 AFS Kerberos 4

Kerberos 5 options include the ability to select the ticket lifetime as well as renew and forwarding. The
Kerberos 5 ticket granting ticket represents the selected identity. As such, obtaining Kerberos 5 tickets is
mandatory.

When Forwardable tickets are received from the Kerberos Server, these tickets can be forwarded to a
remote host when you connect via telnet, ssh, ftp, rlogin, or similar applications. When tickets are
forwarded, there is no need to obtain Kerberos tickets again to access Kerberized services on the remote
host.

When Renewable tickets are received from the Kerberos Server, the ticket lifetimes may be renewed
without prompting the user for her password. This allows Kerberos tickets to be issued with short lifetimes
allowing compromised accounts to be disabled on short notice without requiring the user to enter a
password every few hours. When combined with Automatic Ticket Renewal, NetldMgr can maintain
valid tickets for a week, a month, or longer by automatically renewing tickets prior to their expiration. The
ability to renew tickets without a password is limited by the ticket’s renewable lifetime as issued by the
Kerberos Server.

When Addressless is selected, the tickets do not contain IP address information. This enables the tickets to
be used from behind Network Address Translators which are frequently found in Cable and DSL Modems.
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N jaltman@SECURE-ENDPOINTS.COM - New credentials

Kerberos 4 Ticket Options

Obtain Kerberos 4 tickets ok

Cbtain Kerberos 4 tickets using

{*) Automatically determine method

Cancel

() Kerberos 5 to 4 translation

() Password

e
Identity Kerberos 5 AFS Kerberos 4

Obtaining Kerberos 4 tickets is optional and may not be available on all systems. When available,
Kerberos 4 tickets may only be obtained for a single identity. Kerberos 4 tickets may be obtained via use
of a Kerberos 5 to 4 translation service or by a separate password based request. Selecting “Automatically
determine method” will first try the translation service and if that fails, the password based request will be
attempted. Automatic renewal of Kerberos 4 tickets can only occur if the translation service is used.

N jaltman@ATHEMA.MIT.EDU - New credentials

AFS Token Options

Obtain AFS tokens ok

Token for
Cell cs.cmu.edu v | [ Addjupdate |

Realm | C5.CMU.EDU v

Cancel

Method | (Automatic) v| [ Dekte |

Cell Realm Methaod ’_\

'l:?,; andrew.cmu.edu (Auto) (Automatic)
'l:?,; athena.mit.edu (Auto) (Automatic) —
W €S.CMU.EDU (Automatic)
'Gj; dementia.org (Auto) (Automatic)
|| *

_—
Identity kerberos 5 AFS kKerberos 4

Obtaining AFS tokens is optional and may not be available on all systems. A single identity may be used
to obtain tokens for multiple AFS cells. The Add/Update and Delete buttons are used to manage the list of
AFS cells. If the Kerberos realm associated with the AFS cell cannot be automatically determined, it may
be entered manually. The method of AFS token acquisition is one of: “Automatic”, “Kerberos 5”,
“Krb524” or “Kerberos 4”. Kerberos 5 based tokens should be used when possible. If not, the next best

54

I’*jl
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choice is the 524 translation service. As a last resort, a Kerberos 4 ticket request can be used directly. In
most cases, using “Automatic” will just work.

N jaltman@ATHENA.MIT.EDU - New credentials

Username | jaltman v |

Realm | ATHENA.MIT.EDU v | Ok
Password for jaltman @ATHEMA.MIT.EDU e |

Credentials | Selected identity: jaltman@ATHENA.MIT _EDU Cancel

This identity is the default

Krb5 : Creds for realm ATHENA.MIT.EDU

AFS : Tokens for cells athena.mit.edu, dev.mit.edu, soap.mit.edu, net.mit.
Krb4 : Tickets for realm ATHEMAMIT.EDLU

-
Identity Kerberos 5 AFS Kerberos 4

After entering the correct password for the selected identity, press the Ok button to obtain the specified
credentials.

Renew Credentials Command, Ctrl+R

This command is found on the Credential menu; it is also the second button E (from the left) in the
toolbar. Use this command to renew the selected credentials, Kerberos tickets (and perhaps AFS tokens),
on your local machine without requiring the use of a password.

Import Credentials Command, Ctrl+I

This command is found on the Credential menu; it is also the third button S (from the left) in the
toolbar. Use this command to import the Windows Logon Session Identity. Importing tickets will not
result in the destruction of existing tickets.

Note: This command is only available if your Windows Logon Session is authenticated using Kerberos.

Destroy Credentials Command, Del

This command is found on the Credential menu; it is also the fourth button ﬁ (from the left) in the
toolbar. Use this command to destroy the selected credentials, Kerberos tickets (and perhaps AFS tokens),
on your local machine.

Once credentials are destroyed, you must Get or Import new credentials before Kerberized applications can
once again access network services.

Change Password Command

This command is found on the Credential menu; it is also the fifth button E (from the left) in the
toolbar. This command changes your Kerberos password.
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N jaltman@ATHENA.MIT.EDU - Changing password

Username | i |
Realm | ATHENA.MIT.EDU v|

Changing Kerberos 5 Password

Current Password | |

Mew Password | |

Mew Password again | |

Ok | | Cancel

Note: This command will not change your local machine password unless your Windows Logon Session is
authenticated using Kerberos.
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privacy.

Do choose:

*

*

*

¥ % x x % %k

*

*

How To Choose a Password...
Your passwords are the keys to many computers, from a bank machine to a multiuser mainframe to a
server on a network. Your password helps to prove that you are who you say you are, and ensures your

Compromised passwords are the means by which most unauthorized (and unscrupulous) people gain
access to a system. Someone logging on under your name has access not only to your computer files,
but to most of the facilities of the computer system. Since tampering can have far-reaching and serious
consequences, it's important to take to heart the following guidelines for choosing a password.

Something easy for you to remember with at least six characters.

Something obscure. For instance, you might deliberately misspell a term or use
an odd character in an otherwise familiar term, such as "phnybon" instead of
"funnybone." Or use a combination of two unrelated words or a combination of
letters and numbers.

A combination of letters and numbers, or a phrase like "many colors™ and then
use only the consonants "mnYc0lOrz."

An acronym for your favorite saying, for example, "Llisn!" (Live! It's Saturday
Night!)

Don't choose:

Your name in any form - first, middle, last, maiden, spelled backwards, nickname
or initials.

Your userid or your userid spelled backwards.

Part of your userid or name.

Any common name, such as Joe.

The name of a close relative, friend, or pet.

Your phone or office number, address, birthday, or anniversary.

Your license-plate number, your social-security number, or any all numeral
password.

Names from popular culture, e.g., spock, sleepy.

Any word in a dictionary.

Passwords of fewer than four characters.

Mum's the Word

Never tell anyone your password -- not even your system administrator or account manager -- and don't
write it down. Make sure you have chosen a password that you can remember. And, finally, change
your password at regular intervals

Reprinted from i/s, VVol. 4, No. 9,
May 1989. Revised March 1993.
Copyright C 1993 MIT Information Systems

Before You Begin...
Remember that passwords are case-sensitive, and note whether your keyboard has Caps Lock on.

How To Use Change Password...

abrwdE

Type your username in the first field of the dialogue box.

Type your current password in the Current Password field.

Type your new password in the New Password field.

Retype your new password in the New Password (again) field to verify it
Press Enter or click OK.

The program checks the username and password you entered and notifies you if either is invalid.
If you have entered the new password twice with consistent spellings, Network Identity Manager
replaces your old password with the new, if it is a strong password. If Kerberos determines the
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password is weak, a message notifies you, and you need to repeat steps 1 through 4 with a strong
password, as described by the "How To Choose a Password" guidelines above.

How Change Password Works...
When you type into the password fields of the dialog box characters are replaced with bullets. The program

accepts only printable characters for new passwords, i.e., characters between ASCII codes 0x20 and Ox7E.

When you have entered the new password twice consistently, the program attempts to change the password
via a dialogue with the Kerberos administrative server. Some Kerberos sites, including MIT's Athena
environment, check the password's strength before allowing the change to take place and notifies you if it
determines that the password is weak.

File Credential Wi=.8 Options Help
View columns  #
Layout L4

@Refresh  F5

View Columns
File Credential RYZ"M Options Help

Layaout k| Identity
. v Type
]
®Refresh F5 Tssued on
Expires on

Renewable time expires
v Time Femaining

Renewable Time left

Location

Lifetime

Renewable lifetime

Key EncType

Ticket EncType

Addresses

Krb5 Flags

Cell

Realm

Method

Client Prindpal

server Principal

By default only the Service Name, Identity, Credential Type and Time Remaining are displayed. Using the
View->View Columns menu you can select a variety of other credential properties to display in the
NetldMgr window. After displaying the columns, you can re-organize them by dragging the column
headers into the desired location. The selected configuration will be preserved.
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File Credential @="8 Options Help

View columns  #

v By ety

= By type
s By location
Custom

Layout By ldentity
Layout By Identity is the default layout.

M Network Identity Manager
File Credentiasl View Options Help

DA m& @
o Identity Type Service Name Time Remaining
B @ [3] jzltman@ATHENA MIT EDUV (Deafault)
Karberos 5 tickets
AFS toleans
Kerberos £ fickets
H & [} Ehman@/PLNASAGOV

B Kerberos 5 fickets

Es

1€ hours 12 minutes

Com e z
5‘.3@:;' nas3.gov 18 hours 12 minutes

H & [3] jshman@SECURE-ENDROINTS.COM

B Kerberos 5 ficksts

iy
A
%
]
[= AFS tokens
1 af@sacura—andpoints com 18 minuts
= -|I::I m ia|in‘:s:1@gr_1::.:i.:e:1':rs|.or;
e i
[E AFS tokeans !I\
1 ah@qrand central.org 12 hours 43 minutes |
Layout By Type

Layout By Type provides an alternative view of your credentials ordered by the type of credential instead
of the Identity name.
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M Network Identity Manager
File Credentiasl View Options Help

(OEEA e O

C? Type Igentity Service Mame Time Remaining
B Xerberos 5 tickets

0y [} fEkman@ATHENAMITERY (Pefault)
2 & [y Bliman@/PLNASAGOV
S : 1 GOVEIPLNASAG..
B & [} Bliman@SECURE-ENDFOINTE.COM
|l
B AFS tokens
'6 m e KmanEATHENAMIT EDL! (Defzult)
=) jaltman@JPLNASA.GOV
) R&@(pl namgov 18 hours 1 minutes
= Eltman@SECURE-ENDPPOINTS.COM
1 A 16 minutes
=
| 12 hours £2 minutes
B Kerberos £ ficksts
B @ [y iEman@ATHENAMITEDY (Default) '1
1 kerbEgt ATHENA MITEPU@ATHENA . & howrs £8 mintbes [ |

Layout By Location
The By Location Layout provides an alternate view of your credentials based not upon the Identity name

but instead on their storage location.
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™ Network Identity Manager
File Credential View Options Help

OhhAEe O
B Location

Iqentity Type Service Name Time Remaining

& AF5 Cache Manager

B2 & [§] EEman@SECURE-ENDPOINTS.
B AFS tokens

=2 A [3] EkEman@arand centralorg
b

B AFSfckens

=@qrand.central.org 12 hours 41 minutes
O APLjltman@ATHERA MITEDY

=2 @ m faltman@ATHENAMIT.EDL (Defult)

Kerberos 5 ficksts

= APLjatman@IPL MASA.COV

g's
(2t
%
R}
= APLjaltman@sECURE-ENDPOINTE.COM
3 @ m altman@SECURE-ENDPOINTS.COM
B HKarberos 5 ticksts
&
eatl
'
Ceai
B  AFllrbice
H © [} REman@ATHENAMIT.EDV (Defult)
B HKarberos £ ticksts
| lerbtgt ATHENA MIT EDU@ATHENA. .. & hours 43 minwtes
L '
Custom

Custom views can be obtained by clicking on the column headers to produce an ordering of your choice.

Refresh Command, F5

Use this command (in the View menu and the toolbar @) to update the display of your current
Credentials.

Why Use It...
Although most end users will likely find this feature irrelevant, application developers and support staff

may occasionally find it to be useful. For example, you may want an immediate status check of available
credentials if you have just used command-line Kinit or kdestroy and want to check that they have
functioned successfully.
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While NetldMgr automatically checks the status of your credentials every minute, the Update Display
command forces an immediate status check.

Options:
File Credential View Help
zeneral ...
Appearance ...
Identities ...
Motifications ...
Plugins ...

Kerberos § ...
Kerberos 4 ..,
AFS ...

General Options
The General options dialog, accessed via the Options menu, allows you to configure operational properties

specific to the NetldMgr application.

NetlDMgr Configuration

General options
= Metwork Identity M; »
g o = Startup / Shutdown
[] Appearance Obtain new credentials at startup (if none are present)
B Identities
[ Jatman@co [Jpestroy all credentials on exit
O jaltman@DE
O Jaltman@lp Other
O jaltman@sC
O jaltman@sE Run MetIDMgr in system tray after window dose
O jaltman@w
o tequila @AM Monitor network connectivity
. Enﬁ-}*i:;z:.s@m Log trace events to trace log at the following location:
o Plugins | C:\DOCUME ~1YjaltmanLOCALS ~1Temp'nidmdba.log
= Kerberos 5 2
O Realms
- PrﬁCredenhals v
] >
[ Ok l ’ Cancel

The Obtain new credentials at startup (if none are present) checkbox will determine whether or not
NetldMgr will display the New Credentials dialog at startup when no valid credentials exist.

The Destroy all credentials on exit option can be used to empty all of the credential caches when the
NetldMgr is terminated.
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x

The Run NetldMgr in system tray after window close checkbox determines the behavior of the .
window close button. When checked, NetldMgr will close the window but will continue running and can
be accessed from the system tray. When unchecked, NetldMgr will behave as if File->Exit was selected
from the menu.

The Monitor network connectivity option determines whether or not NetldMgr monitors the
configuration of IP addresses on the machine. When IP addresses are added or removed and this feature is
activated, the NetldMgr will probe the identity management servers (e.g., Kerberos Key Distribution
Centers) to determine if they are reachable and if so will automatically obtain credentials.

The Log trace events to trace log at the following location option is used to activate a log file that can be
used to help debug the behavior of NetldMgr and its plug-ins.

Appearance Options

The Appearance Options page can be used to select an alternate typeface to be used when displaying
credentials in the NetldMgr.

NetlDMgr Configuration

Appearance

= [ Metwork Identity M
O General

o Font name |I'~'1i|:ru:|su:|1"t Sans Serif V|
= Identites

ja:h'nan @ Size [ ecld [ 1talics
jaltman@&DE

jaltman@rP .
jaltman @St Sample text {nomal). 01234567850

jaltman@se
jaltman@w Sample text (selected). 012345673890
tequila@aAN
jaltman@Al
[ Motifications
0 Plugins
B Kerberos 5
O Realms
[ Credentials

—_ A,

£ >

Faont for credentials display

i o |

[ Revert to default

Ok l ’ Cancel

Identities Options

Identity Options fall into two broad categories: global settings used as default values for Identities and
Identity specific values that override the defaults.

Global Identity Settings
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NetlDMgr Configuration

Global Identity settings
B [ Metwork Identity Mi 4

O General i General |KErI:ueru:us 5 || AFS Kerberos 4
O Appearance
=g [+] Monitor credential expiration
jaltman@Ce Automatically renew
jaltman@DE
jaltman@Jr
jaltman@sC
jaltman@sE
jaltman@w
tequila @AM
jaltman@al
[ Motifications
O Plugins
= Kerberos 5 2
[ Reams
O Credentials 3

—_ A~ —

< | >

[ ] always show in the credentials list (Finned)

e o o s o o |

Ok l ’ Cancel

There are three general settings that can be used to set global defaults.

The Monitor credential expiration setting determines whether or not NetldMgr should monitor the
credential lifetimes and issue expiration notifications. This value is used as the default for all new
identities.

The Automatically renew setting determines if renewable credentials are automatically renewed prior to
expiration. This value is used as the default for all new identities.

The Always show in the credentials list (Pinned) setting determines whether new identities are always

pinned within the credentials list. A pinned identity will always be displayed regardless of whether or not
there are credentials associated with it.
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NetlDMgr Configuration

B [ Metwork Identity Mi 4
O General T
O Appearance
B Identities
jaltman@C
jaltman@DE
jaltman@Jr
jaltman@sC
jaltman@sE
jaltman@w
tequila @AM
jaltman@al
[ Motifications
O Plugins
= Kerberos 5 2
[ Reams
[ Credentials

—_ A~ —

| *

o s s e o o |

| #

Global Identity settings

General | Kerberos 5 | AFS | Kerberos 4

Ticket lifetime | 10 hours |

Ticket renewable lifetime | 7 days |

Ticket lifetime range

Minirmum | 1 minute |

Maximum | 1day |

Ticket renewable lifetime range

Mirimurm | 1 minute |

Maximum | 30 days |

[ Ok | | cancel |

The global Kerberos 5 settings define default credential lifetimes and minimum and maximum values for
use in constructing the slider controls used to set the lifetimes.

There are two expiration times associated with Kerberos tickets. The first specifies the length of the time
period during which the tickets are valid for use. The second specifies the length of the renewable lifetime.
Valid Kerberos tickets may have their valid use lifetime repeatedly extended up until the renewable lifetime
expires. The settings on this page are used to configure default lifetime values for NetldMgr to use when
requesting Kerberos tickets from the Kerberos server (key distribution center). The Kerberos server may
issue tickets with shorter lifetimes than were requested.

The minimum and maximum values are used by the ticket initialization dialog box when constructing the
Lifetime and Renewable Lifetime sliders. These sliders can be used to modify the requested ticket
lifetimes when Kerberos tickets are initialized.
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NetlDMgr Configuration

Global Identity settings
= @ Metwork Identity Mi

[ General i General || Kerberos 5| AFS |Kerl:uer|:|s4
[0 Appearance
B Identities Obtain AFS tokens for new identities
jaltman@Ct
jaltman@DE
jaltman@IP
jaltman@sC
jaltman@sE
jaltman@w
tequila @AM
jaltman@AT
[ Motifications
O Plugins
= Kerberos 5 LB
[ Realms
[ Credentials 3

—_ Aars —

| >

OODODOODOO0OOO

|l

Dk l ’ Cancel App

When the Obtain AFS tokens button is checked, NetldMgr will attempt to retrieve AFS tokens when
ticket initialization, renewal, or importation is performed. If you do not frequently access AFS cells, it is
suggested that this button be unchecked.
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NetlDMgr Configuration

Global Identity settings
= g Metwork Identity Mi

o General | | General | Kerberos 5| AFS | Kerberos 4

[0 Appearance
=g Identities Obtain Kerberos 4 tickets
jaltman@Cc
jaltman@DE
jaltman@ar
jaltman@sC
jaltman@SE
jaltman@wy
tequila @AN
.jalhjan@.ﬁ.'l Mote that, if enabled, Kerberos 4 tickets will be acquired during initial

[ Motifications credential acquisition and during credential renewals.

O Plugins
=g Kerberos 5 _ However, currently Kerberos 4 tickets can only be obtained for the
default identity.

o o o o o

[] Realms
[0 Credentials 3

—_ A, —

< | ¥

[ Ok | [ conesl |

When the Obtain Kerberos 4 credentials button is checked, NetldMgr will attempt to retrieve Kerberos 4
credentials when ticket initialization, renewal, or importation is performed. Kerberos realms are
increasingly configured to support only Kerberos 5 (e.g., Windows Active Directory Domains.) If the
realms you use do not support Kerberos 4 it is suggested that this button be unchecked.

Be aware that only the default identity can obtain Kerberos 4 credentials. This limitation is due to the
inability of Kerberos 4 applications on Microsoft Windows to specify a credentials cache.

Identity Specific Options
Each Identity knows to the Network Identity Manager is provided its own set of tabbed pages that can be

used to override the default values specified on the Global Identity Settings pages. There are two
distinctions.
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NetlDMgr Configuration
Options for jaltman@ATHENA.MIT.EDU

= @ Metwork Identity M; | J—
[ General General | Kerberos 5| AFS | Kerberos 4|
[0 Appearance

= Identities Monitor credential expiration
jaltman@C Automatically renew

jaltrman@DE
;alh'nan@JP Always show in the credentials list (Pinned)

jaltman@sC
jaltman@sE
jaltman@w
tequila @AM
[ Motifications
O Plugins
= Kerberos 5 LB
[ Realms
[ Credentials 3

—_ Aars —

| >

OODODOODOO0OOO

|l

Dk l ’ Cancel App

The General page contains a Remove ldentity button that can be used to delete this Identity from the
Network Identity Manager.

NetlDMgr Configuration
Options for jaltman@ATHENA.MIT.EDU

= [ Metwork Identity Mi A

@ General General | Kerberos 5 |.-5.FS | Kerberos 4|
O Appearance
o Identities Ticket lifetime (b day |
jaltman@Cc
jaltman@DE

jaltman@Jp Renewable for | 7 days |
jaltman@sC

jaltman @SE Can be forwarded to other machines
jaltman@w
tequila @AM Addressless
jaltman@AT
@ Motifications
O Plugins
=@ Kerberos 5 =
[ Realms
[ Credentials 3

—_ A —

< | >

o o I s o o

Credentials cache | APT:jaltman @ATHENA.MLT.EDU

[ ok | [ cancel || e
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The Kerberos 5 page displays the name of the credential cache currently associated with the Identity.

NetlDMgr Configuration

= [ Metwork Identity M; ~

O General

O Appearance

=g Identities

jaltman@Cc
jaltman@DE
jaltman@IP
jaltman@sC
jaltman@SE
jaltman@w
tequila @AM
jaltman @Al
[ Motifications
O Plugins
Kerberos 5 -
[ Realms
[0 Credentals 3

—_ A —

< | >

OODOOD OO OOO

Options for jaltman@ATHENA.MIT.EDU

General || Kerberos 5 | AFS

| Kerberos 4

Obtain AFS tokens
Token faor

cell | athena.mit.edu e | Add/Update
Realm | (Automatic) v|

Method | (Automatic) w | ﬂ]
Cell Realm Method #
l:_?,; andrew,cmu.edu {Auto) (Automa.
l:_?,; athena.mit.edu {Auto) (Automa.
{4 cs.omu.edu CS.CMU.EDU (Automa.
l:_?,; dementia.org {Auto) (Automa.
£ | [*

[ ok

| [ cancel AP

The AFS page is optional and may not appear on all systems. A single identity may be used to obtain
tokens for multiple AFS cells. The Add/Update and Delete buttons are used to manage the list of AFS
cells. If the Kerberos realm associated with the AFS cell cannot be automatically determined, it may be

entered manually. The method of AFS token acquisition is one of: “Automatic”, “Kerberos 57, “Krb524”
or “Kerberos 4”. Kerberos 5 based tokens should be used when possible. If not, the next best choice is the

524 translation service. As a last resort, a Kerberos 4 ticket request can be used directly. In most cases,
using “Automatic” will just work.
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NetlDMgr Configuration
Options for jaltman@ATHENA.MIT.EDU

= g Metwork Identity Mi
o General | | General | Kerberos 5 | aFs | Kerberos 4
[0 Appearance }
=@ Identities Obtain Kerberos 4 tickets for this identit
jaltman@Cc
jaltrman @DE
jaltman@IP
jaltman@sC
jaltman@sE
jaltman@w
tequila@AaM
jaltman@AT
@ Motifications
[ Plugins
= Kerberos 5 =
[ Realms
[ Credentials

—_ A —

| >

OODODOODOO0OOO

|

Ck l ’ Cancel App

The Kerberos 4 page is optional and may not appear on all systems. Only one identity can obtain Kerberos
4 credentials at a time.

Notifications Options

Page 28



Network ldentity Manager User Documentation Release 3.1.0

NetlDMgr Configuration

Notifications
= g Metwork Identity M

O General | [¥]Renew automatically at | 15 minutes |
[0 Appearance
- Identities Renew at half life intervals when possible
jaltman@Ct -
jaltman@0E Initial warning at | 10 rinutes |
jaltman@IP
jaltman@sC Final warning at | 5 minutes |
jaltman@sE
jaltman@w
tequila@am

m jaltman@Al
.
O Plugins
=+ Kerberos 5 -
[ Realms

?rﬁCrEdenhals 3

| ?

o o o o |

| .8

Ok l ’ Cancel

The Renew automatically at check box determines whether or not renewable tickets will be renewed by

NetldMgr when they reach the specified time remaining.

The Initial warning at check box determines whether or not a warning will be issued when the specified

time remaining is reached.

The Final warning at check box determines whether or not a warning will be issued when the specified
time remaining is reached.

Notifications are performed in two ways. First, icons are displayed next to the affected credentials in the

flags column of the display. Second, a balloon tip is displayed off of the NetldMgr system tray icon.

Plugins and Modules
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NetlDMgr Configuration

Plugins and Modules
= g Metwork Identity Mia

O General Plugins Kerberos 5 Credentials Provider

[0 Appearance E *ﬂ
= Identities E AfsCred
jaltman@C¢ & Krb4cred Module | MITKrhS |

jaltman@DE 2 Krbsident _
@ Version | 1.1.0.1 |

jaltman@sC
Jaltman@sE Vendor | (C) 2005 Massachusetts Institute of
jaltman@wy
tequila @AM
jaltman@al
[ Motifications

[ Plugins Status RUNNINg |

= Kerb 5 L3

Depends on

o o o e o o

O Realms
O Credentials 3

— A, — -

< | >

[t
o
=)

1

Ok | | cancd | nol

The Plug-ins and Modules page provides status information on the currently loaded plugins and modules
include a description of their purpose; whether or not it was loaded properly; which other modules are
required; and what organization developed it.

Kerberos 5 Configuration
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NetlDMgr Configuration

Kerberos 5 Configuration

= g Metwork Identity Mi#
o Generl DefsultRealm | ATHENA,MIT.EDU v|
[0 Appearance
B+ Identities
jaltman@Cc
jaltman@DE
jaltman@IP L | C\WINDOWS kb 5.ini | [ Browse...
jaltman@sC
jaltman@sE [ ]indude realms in Mew Credentials realm list
jaltman@w
tequila @AM
jaltman@al Windows®& Options
o Nu:uhﬁu:ahu:uns Hostname |CERBERLIS |
O Plugins
2 Domain [ winpows |
O Realms
O Credentizls 3 Import tickets |.-5.Iwa1,-'s V|

Keberos Configuration File

i o e o o o o

P

< ¥

[ ok | | conce

In the Default Realm field, select a Kerberos realm from the dropdown list.

The Kerberos 5 Configuration tab allows you to specify the location of the Kerberos 5 configuration file.
The Configuration File field specifies the path to the Kerberos 5 configuration file, krb5.ini.

The Kerberos libraries depend on configuration files for their proper operation. When Create file if
missing is checked, NetldMgr will construct replacements for missing configuration files upon startup.
This is performed by extracting Kerberos configuration information from the local Windows registry and
the Domain Name System. The contents of the created file may then be edited using the Kerberos
Properties Dialog. [This functionality is not available in this release.]

The Kerberos 5 configuration file frequently contains lists of realms and associated Kerberos server
location information. If you wish this list to be used to populate the realm list in the Obtain New
Credentials dialog, check the Include realms in New Credentials realm list box.

The field labeled Host Name displays the name of your local machine. The Domain Name field displays
the domain to which your local machine currently belongs.

The Import Tickets listbox allows you to configure how NetldMgr interacts with the Microsoft Kerberos
Authentication Provider. NetldMgr will automatically import Kerberos Tickets from the Microsoft LSA at
startup depending upon the selected option and whether or not the Kerberos Authentication Provider was
used for Windows Logon authorization. Never means do not import tickets from the MSLSA; Always
means do import tickets from the MSLSA,; and Only when the Principal matches means import tickets
from the MSLSA only if the MSLSA Kerberos principal belongs to the Default Realm.
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NetlDMgr Configuration

= @ Metwork Identity M #
O General i
[0 Appearance
= Identities
jaltman@Cc
jaltman@DE
jaltman@IP
jaltman@sC
jaltman@sE
jaltman@w
tequila@aM
jaltman@Al
O Motifications
@ Plugins
Kerberos 5
[0 Realms
[ Credentials 3

—_ A —

| ¥

o o o |

Kerberos Realm Configuration

L] <Mew realm... = -~

(] ANDREW.CMU...
] anL.GOV

[=] ATHEMA.MIT.EDI
] cc.CoLUMEIA...
(] cs.cMU.EDU

(] £saIL.MIT.EDU

(] DEMENTIA.CRG
O] FOO.WINDOWS.—
(] GRAMD.CENTR..
(] 1ASTATE.EDU

(] JPL.NASA.GOV

(] KRES.COLUMBL. v
< | >

Kerberos Servers for ATHEMA,MIT.EDL

Server Admin Master
L] <Mew server....

[=] kerberos.mit.... Yes Yes
[ kerberos-1.mi... Mo Mo

[ kerberos-Z.mi... Mo Mo

[ kerberos-3.mi... Mo Mo

Domains that map to ATHEMA.MIT.EDLU
Domain

L1 <Mew domain mapping... =

W] e

ok

I=ml

The Kerberos Realm Configuration dialog can be used to manage the contents of the [Realms] and
[Domain_Realm] sections of the Kerberos 5 configuration file.

Apply ]

NetlDMgr Configuration

Kerberos 5 Credentials Caches

=0 réebgz;kelrd;nhty M Incude Windows LSA cache (MSLSA:)

[0 Appearance

= Identities

jaltman@Cc
jaltman@DE
jaltman@rP
jaltman @sC
jaltman @SE
jaltman @w
tequila@aN
jaltman @Al
O Motifications
O Plugins
Kerberos 5 - |
[ Realms

o BEEER, |

—_ A

< | >

File Caches

File based Credential Caches
c:document and settings'jaltmanikrb5s.co

e s o o o e |

| [ Browse ...

Add ] [ Remove Selected ]

[ Ok | | canct | s
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The Kerberos 5 Credentials Caches page determines the contents of which credential caches types are
displayed within the Network Identity Manager. The Include all API: credential caches check box
determines whether or not CCAPI caches are included. CCAPI caches are the most frequently used with
MIT Kerberos for Windows. The Include Windows LSA cache (MSLSA:) check box determines
whether or not the Windows Logon Session Identity is displayed within NetldMgr.

The Network Identity Manager can also display the contents of FILE: credential caches. Each FILE:
credential cache must be manually added to the list.

AFS Configuration
NetlDMgr Configuration

AFS Configuration

[0 Appearance -

= Identitiee AFS Service
O jaltman @t Service status | Running |
O jaltman@DE :
O jaltman@IpP
O jaltman@sr
o jaltman@se Version | 1.5.0000 |
i i)
g ilzjifang .-:I':IJ Company | OpenAFS Project |
O jaltman@al
o Motifications Startup options
O Plugins Prevent AFSCreds.exe from starting automatically everytime you
=g Kerberos 5 log in to Windows.
[ Realms
Credentials
O &
[ Kerberos 4
[ Open AFS Contral Panel ...
£ >

ok | [ coneel |

The AFS Configuration page is optional and may not appear on all systems. The AFS page can be used to
stop and start the AFS Client Service, view the AFS version number and distribution source, and access the
AFS Control Panel.

The Prevent AFSCreds.exe from starting automatically everytime you log in to Windows feature will
disable the use of the AFS System Tray application known as afscreds.exe. This feature is required until
such time as the NetldMgr replaces afscreds.exe in the OpenAFS distribution.

Kerberos 4 Configuration
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NetlDMgr Configuration

Kerberos 4 Configuration

O Appearance -
= Identities "~ Ticket cache location | APT:krb4cc |
jaltman@Ce
jaltman@0E Config file path | C:AWINDOWSrb. con | [ Browse... ]
jaltman@ar
jaltman@sC | Realm file path |C:\WINDOWS\}vbrealm-mn | | Browse... |
jaltman @SE
jaltman@w
tequila@an
jaltman @Al

[ Motifications

O Plugins
=g Kerberos 5

[ Realms
O Credentials
[ AFS

- EEEE

< | >

o s o s o |

Ok l ’ Cancel

Here, you can specify the name of the in-memory cache used to store the Kerberos 4 tickets. The format of
the name is “API.” followed by the cache name. Disk caches are not supported by Kerberos for Windows.

The paths to the Kerberos 4 configuration files: krb.con and krbrealm.con may be changed from this dialog
if necessary. The default is to store the configuration files in the Windows directory.

Help:
File Credential View Options
,f"lu_l:u:untext
Contents ...
Index ...
About MNetIDMar ...

About Network Identity Manager
When you access this window from the Help menu, you see a Module list, three radio buttons, and a

Properties button. Modules are executables and dll files that NetldMgr may require.
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About Network Identity Manager E]
g I| NetIDMgr 1.1.0.1.PRIVATE

(C) 2005 Massachusetts Institute of Technology
Private build. Please send bug reports to kfw-bugs@MIT.EDU

Loaded modules

Mame Path =
appHelp.dil CWINDOWS \system32\appHelp. dil B
msi.dll CAWINDOWS \system 32 msi.dll
MsVCPaD.dll CWINDOWS \system3Z\WMsSVCPa0. dll
CLEACC.dI CAWINDOWS \system32\OLEACC . I
msimtf.dll CAWINDOWS \System 32 \msimtf.dll
MLANG.dI C:\WINDOWS \system32\MLANG. di
msls31.dll CyWINDOWS\System 32 msls3 1. dll
michtrml Al o WAHTRIDMAAS WS waetam 32 maehtml Al | . 1
<

The About dialog provides access to the Network Identity Manager version number; the applicable
copyright statement; the e-mail address to which bug reports should be sent; and a list of all of the modules
loaded by the application.
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System Tray

While NetldMgr is running the ) icon will be displayed in the system tray. Clicking on the icon with
the first mouse button will open or close the Network Identity Manager display window. Clicking with the
second mouse button will display a menu of commands.

A =all credentials are valid

» = some credentials are about to expire

A" =some credentials are expired

System Tray menu

Open MetIDMgr ...
" Mew credentials ... CTRLHM
[ Renew credentizls
B Destroy credentials ... Del

Exit CTRL+X

Open NetldMgr ...
The Open NetldMgr ... command will restore the Network Identity Manager Ticket Display window. If

the window is already open this option will appear as “Close NetldMgr ...”.

Get Ticket(s)/Token(s)
Renew Ticket(s)/Token(s)
Import Tickets

Destroy Ticket(s)/Token(s)

Change Password
The Network Identity Manager Commands: Credentials section of this document describes these

commands

m
=

Xi
You can use this command to exit the Network Identity Manager.

Important Note...
Exiting NetldMgr will not destroy your current Kerberos tickets.
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Toolbar
Chnfae O

The Network Identity Manager Toolbar contains buttons which act as shortcuts to the most frequently used
Actions found on the Menubar. From left to right:

Get Tickets

Renew Tickets

Import Tickets

Destroy Tickets

Change Password

Update Display

ocouapwdRE
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Copyrights

Network Identity Manager Copyright

This software is being provided to you, the LICENSEE, by the Massachusetts Institute of Technology
(M.L.T) under the following license. By obtaining, using and/or copying this software, you agree that you
have read, understood, and will comply with these terms and conditions:

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee or royalty is hereby granted, provided that you agree to comply with the following copyright
notice and statements, including the disclaimer, and that the same appear on ALL copies of the software
and documentation, including modifications that you make for internal use or for distribution:

Copyright 1992-2005 by the Massachusetts Institute of Technology. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS", AND M.IL.T. MAKES NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not limitation, M.I.T. MAKES NO
REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE OR
DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS,
TRADEMARKS OR OTHER RIGHTS.

The name of the Massachusetts Institute of Technology or M.1.T. may NOT be used in advertising or
publicity pertaining to distribution of the software. Title to copyright in this software and any associated
documentation shall at all times remain with M.L.T., and USER agrees to preserve same.

Project Athena, Athena, Athena MUSE, Discuss, Hesiod, Kerberos, Moira, OLC, X Window System, and
Zephyr are trademarks of the Massachusetts Institute of Technology (MIT). No commercial use of these
trademarks may be made without prior written permission of MIT.

Kerberos Copyright

This software is being provided to you, the LICENSEE, by the Massachusetts Institute of Technology
(M.L.T.) under the following license. By obtaining, using and/or copying this software, you agree that you
have read, understood, and will comply with these terms and conditions:

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee or royalty is hereby granted, provided that you agree to comply with the following copyright
notice and statements, including the disclaimer, and that the same appear on ALL copies of the software
and documentation, including modifications that you make for internal use or for distribution:

Copyright 1992-2006 by the Massachusetts Institute of Technology. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS I1S", AND M.1.T. MAKES NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not limitation, M.I.T. MAKES NO
REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE OR
DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS,
TRADEMARKS OR OTHER RIGHTS.

The name of the Massachusetts Institute of Technology or M.I.T. may NOT be used in advertising or

publicity pertaining to distribution of the software. Title to copyright in this software and any associated
documentation shall at all times remain with M.1.T., and USER agrees to preserve same.
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Project Athena, Athena, Athena MUSE, Discuss, Hesiod, Kerberos, Moira, OLC, X Window System, and
Zephyr are trademarks of the Massachusetts Institute of Technology (MIT). No commercial use of these
trademarks may be made without prior written permission of MIT.

Kerberos Export Restrictions and Source Code Access

Copyright (C) 1989-2006 by the Massachusetts Institute of Technology

Export of this software from the United States of America may require a specific license from the
United States Government. It is the responsibility of any person or organization contemplating
export to obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the above copyright notice
appear in all copies and that both that copyright notice and this permission notice appear in supporting
documentation, and that the name of M.I.T. not be used in advertising or publicity pertaining to distribution
of the software without specific, written prior permission. M.1.T. makes no representations about the
suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Export of the documentation is not restricted.
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Reporting Bugs and Requesting Assistance

If you find bugs, please mail them to kfw-bugs@MIT.EDU.

kerberos@MIT.EDU is a mailing list set up for discussing Kerberos issues. It is gatewayed to the Usenet
newsgroup ‘comp.protocols.kerberos'. If you prefer to read it via mail, send a request to kerberos-
request@MIT.EDU to get added or subscribe via the web page:

http://mailman.mit.edu/mailman/listinfo/kerberos
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Obtaining Kerberos for Windows Source Code and SDK

To retrieve the source code distribution or software development kit for Kerberos for Windows follow the
link to Download: Souces and binaries from MIT via authorization form from the web page
http://web.mit.edu/kerberos/.
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Important notice regarding Kerberos 4 support

In the past few years, several developments have shown the inadequacy of the security of version 4 of the
Kerberos protocol. These developments have led the MIT Kerberos Team to begin the process of ending
support for version 4 of the Kerberos protocol. The plan involves the eventual removal of Kerberos 4
support from the MIT implementation of Kerberos.

The Data Encryption Standard (DES) has reached the end of its useful life. DES is the only encryption
algorithm supported by Kerberos 4, and the increasingly obvious inadequacy of DES motivates the
retirement of the Kerberos 4 protocol. The National Institute of Standards and Technology (NIST), which
had previously certified DES as a US government encryption standard, has officially announced[1] the
withdrawal of the Federal Information Processing Standards (FIPS) for DES.

NIST's action reflects the long-held opinion of the cryptographic community that DES has too small a key
space to be secure. Breaking DES encryption by an exhaustive search of its key space is within the means
of some individuals, many companies, and all major governments. Consequently, DES cannot be
considered secure for any long-term keys, particularly the ticket-granting key that is central to Kerberos.

Serious protocol flaws[2] have been found in Kerberos 4. These flaws permit attacks which require far less
effort than an exhaustive search of the DES key space. These flaws make Kerberos 4 cross-realm
authentication an unacceptable security risk and raise serious questions about the security of the entire
Kerberos 4 protocol.

The known insecurity of DES, combined with the recently discovered protocol flaws, make it extremely
inadvisable to rely on the security of version 4 of the Kerberos protocol. These factors motivate the MIT
Kerberos Team to remove support for Kerberos version 4 from the MIT implementation of Kerberos.

The process of ending Kerberos 4 support began with release 1.3 of MIT Kerberos 5. In release 1.3, the
default run-time configuration of the KDC disables support for version 4 of the Kerberos protocol. Release
1.4 of MIT Kerberos continues to include Kerberos 4 support (also disabled in the KDC with the default
run-time configuration), but we intend to completely remove Kerberos 4 support from some future release
of MIT Kerberos, possibly as early as the 1.5 release of MIT Kerberos.

The MIT Kerberos Team has ended active development of Kerberos 4, except for the eventual removal of
all Kerberos 4 functionality. We will continue to provide critical security fixes for Kerberos 4, but routine
bug fixes and feature enhancements are at an end. We recommend that any sites which have not already
done so begin a migration to Kerberos 5. Kerberos 5 provides significant advantages over Kerberos 4,
including support for strong encryption, extensibility, improved cross-vendor interoperability, and ongoing
development and enhancement.

If you have questions or issues regarding migration to Kerberos 5, we recommend discussing them on the
kerberos@mit.edu mailing list.
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